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1. BEGINNING
MultiTerminal belongs to the MetaTrader 4 online trading platform and intends to:
• Handle a set of client accounts
• Perform trade operations
• Control and deal with both open positions and pending orders
• Receive prices and information in the online mode
The platform works on Microsoft Windows 98SE and higher.
1.1.

Security System

This segment contains basic details that you need to know when you start working with the client terminal:
•
•
•
•

Protection system
Live update
Terminal settings
Protection system

Attention:
• The advanced, digital electronic signature-based security system can be activated on the server.
• If the advanced protection system is activated for a trading account, it is important that the produced
RSA keys are transferred to this other computer for work on another device. The keys represent KEY
extension files, and are stored in the folder /profiles.
• If any key has been lost or harmed, contacting the technical support carrier for the brokerage under
taking is necessary.
1.2.

Live Update

There is a live update framework (LiveUpdate) built into the terminal. It helps us to get directly updated on
and update new versions of the software. This device is continuously working and can not be deactivated.
Attention:
•
•
1.3.

If there is no server connection, then the process for live updating will not start.
The Technical Guide Provider must be told if any issues occur with live updating.
Terminal Settings

MultiTerminal is-set up in a special window that can be called by the menu command “tools — options” or
by using Ctrl+O keys to accelerate. All settings are grouped according to their responsibilities and put in the
tabs below:
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• Server - setting up application link parameters, configuring the web and data centers used proxy
service and other settings;
• Trade - conditions by default for opening new orders. They consist of the financial instrument (symbol),
lots number, allocation mode for lots, and deviation;
• Email - set requirements for email addresses. If there is a need to send messages directly from the
terminal via email, the parameters should be set to the email box to use;
• Events - setting up signals that warn about events in the system. Signals informing about the unavailability
of the link, news revenues, and others, greatly simplify the work.
1.4.

Server

The Terminal is based on server-incoming data continuously. If a terminal does not take quotes, so trading
with it is not possible. The Server tab contains server link settings.
1.4.1. Server
Choosing one of the available servers from that list is important.
MultiTerminal does not allow switching between the servers of different firms, since it is closely linked to the
servers of a certain organization.
1.4.2. Proxy Server
Link to the internet via a proxy server may be another purpose the server can not be linked to. A proxy server
is an interface between the trader’s machine and the server for trading. It’s used mostly by internet providers
or local networks. If there is a communication issue you need to contact your system administrator or the
internet provider. When using a proxy the terminal must be set up accordingly. Setting the checkbox “enable
proxy server” will allow support from the proxy server and trigger the button “Proxy ....” Pressing this button
will open the window where the parameters of the proxy server should be specified (these data can be administered by the device).
• Server - the address and form of proxy servers (HTTP, SOCKS5, or SOCKS4);
• Login - User profile for proxy server access. If login is not necessary this field must remain empty;
• Password-a proxy server login token. This field must remain empty if password is not necessary.
After defining the parameters, it is recommended that you press the “test” button to check how the settings
operate. If they have been checked successfully, select the “yes” button so that the settings are accurate.
The error message means the proxy server is improperly configured. The system administrator or internet
provider needs to be contacted again to discover the reasons.
1.4.3. Non-Public Data
The terminal is configured for the management of a series of client accounts. Specifying username (account
number) and password is important when adding accounts. Once an account has been installed, and if the
option “keep personal settings and data at startup” is allowed, it will save the password on the hard disk. This
password will be used to automatically connect the account when connecting to the server. If the option is
deactivated, a password must be entered manually at each account link. In addition, if the option is disabled,
all private emails received via the internal email system will be removed.
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1.4.4. News
Terminal allows for prompt receipt of financial information. They begin to earn revenue just after connecting
to the server. No news released on disconnection of the terminal would have income in it. To enable news to
be transmitted, “enable news” must be flagged.
1.5.

Trade

Settings used for the opening of orders are listed in the Commercial tab. Here input parameters promote
order opening and can not induce crucial changes in terminal operation.
1.5.1. Symbol Through Default
The choice “symbol by default” allows you to specify the value of the symbol when a trading operation is
performed. The “last used” parameter implies automatic setting of the symbol of the current trade action. The
“Ordinary” parameter has to be allowed for the same symbol to be set again and again, and the appropriate
symbol should be selected from the list.
1.5.2. Lots By Default
Similarly, the initial lots can be specified (‘default lots’ choice): ‘final used’ is the parameter used in the previous procedure, and ‘use default’ is a standard, manually set cost.
1.5.3. Masses Allocation
When placing new orders, determining the total allocation of lots for all accounts is by far necessary. The stated general lots shall be allocated among bills according to the method of allocation of the necessary masses:
• Predefined volume - it’ll be necessary to specify manually the plenty amount for each order while putting
the order, later this predefined volume will follow at setting orders.
• General extent for every order - the whole lots will observe at placing each order.
• Same parts - the whole lots might be allotted amongst all orders in identical parts.
• With the aid of equity ratio - the overall masses can be allotted among orders based at the ratio among
equities of debts.
• Through unfastened margin ratio - the total masses might be allotted amongst orders on the ratio
between unfastened margins of money owed.
Attention:
•

The “Lots Allocation” alternative allows defining the approach to allocating lots amongst debts at setting
orders: “the ultimate used to cost” - parameter used within the previous operation, or “by using the
default” - plenty allocation approach defined manually.

•

When the whole volume is allotted among orders on bills with exceptional deposit currencies primarily
based on equity ratio or unfastened margin ratio, the fairness or unfastened margin are added to the
precise currency that can be selected inside the context menus of the bills panel and the Orders or
records tabs.

•

Deviation
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During the ordering time the picture charges an alternative. As a result, the unified order charge will not now
equate to the one on the marketplace, and the service will not open now. This is prevented by the “Deviation”
method. On this issue, the most reasonable deviation from the price given within the order may be certain.
If charges no longer fit, the software modifies the order by itself which allows it to open a brand new feature.
1.6.

Email

In the Email tab, the electronic mailbox is set up. Later on, these settings will be used to send a message
by a triggered alert. To start setting up email, the “Enable” must be enabled and the following fields must be
filled out:
• SMTP server - address of the SMTP server used and port. The given server will be used for sending
messages. The entry must have the following format “[internet address-server address]:[port number]”.
For example, “192.168.0.1:443”, where “192.168.0.1” is the server address, and “443” is the port number;
• SMTP login - login to authorize at the mail server;
• SMTP password - authorization password;
• From - e-mail address from which messages will be sent;
• To - the email address to which messages will be sent.
Attention: Only one email address may be specified for either of fields “From” and “To”. Several emails given
with or without separators will not be accepted.
“Test” sends a testing message using the settings specified to test their workability. If it has been tested
successfully, the “OK” button must be pressed to apply these settings. If the test is unsuccessful, it is recommended to check all settings and resend the test message.
1.7.

Events

Signals of system events can be set up in the terminal (not to be mixed up with alerts). It is a very convenient
tool for informing about changes in the terminal status. Signals can be set up in this tab. For this to be done,
the “Enable” option must be enabled first. At that, a table containing the list of system events and corresponding actions will become active. System events are:
• Connect - connection to the server. Signal of successful connection to the server;

• Disconnect - no connection to the server. Signal of interrupted connection to the server;

• Email Notify - notifying about an incoming mail. If this signal has triggered, it is recommended to check
the “Toolbox - Mailbox” window;
• Timeout - a certain time range is predefined for performing trade operations. If this range has been
exceeded for some reason, the operation will not be performed, and this signal will trigger;
• OK - trade operation has been successfully performed. No errors occurred during the performance
of this operation;
• News - receiving of news. If this signal has triggered, it is recommended to check the “Toolbox —
News” window;
• Requote - price changed during the preparation of a trade operation.
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If any of the signals need to be deactivated, double-click the name or symbol with the left mouse button.
Each double click turns it on again. The file listed in the “Action” field for the corresponding event will run after
the signal has triggered. A double-click on the name of the file lets you change the file. After double-clicking
there will appear a pop-up list of available files to be allocated to the case. Selecting any file from this list and
pressing the Enter button further ensures it will be allocated to the corresponding case. You have to press the
“Yes” button to confirm any changes made.
Attention: Any file executable in the operating system can be assigned to the event.

2. CLIENT ACCOUNTS
This section describes how to work with client accounts in the multiterminal:
2.1.

Adding Accounts

MultiTerminal intends to manage multiple accounts. Accounts that can be controlled using the terminal are
listed in the “accounts” window. If one needs to control another account, they should add this account into the
terminal. a new account to be controlled can be added using the “file - New Account” menu command, the
corresponding button in the toolbar, or using the “New Account” command of the “accounts” window context
menu.
When adding an account, it is essential to enter login in the “New Account” window. The account password
also can be entered.
Attention:
If the option of keeping personal details is enabled in the server settings, the entered password will be stored
on the hard disk and used at the next connection to the server. Otherwise, it will be necessary to enter the
password manually whenever starting the connection.
An account can be deleted from the list of managed accounts using the “Delete Account” command of the
“Accounts” context menu.
2.2.

Connecting Accounts

To start managing trade accounts, it is important to connect them to the server. information, quotes, mail
messages start coming in the terminal following the connection, one can control trade positions and place
orders then.
The “file - connect all” menu command, the corresponding button in the toolbar, or the “connect all accounts”
command in the “accounts” window context menu, can be used to join all accounts to the server. You can
connect a separate account to the server using the “connect account” command in the context menu for the
“accounts” window.
Attention: The terminal sets barriers regarding the number of simultaneously connected demo accounts. Just
10 demo accounts can be connected to the server simultaneously from the managed money owed list. As for
the individual accounts, the maximum number of linked accounts at the same time is 128.
PRIMUS MARKETS INTL Limited
Address: Govant Building, BP 1276, Port Vila, Vanuatu
Phone: +27 105004213
E-mail: support@fxprimus.com
Company Number 14595
FXPRIMUS.com/INT

5

You can detach all accounts from the server using the menu command “File - Disconnect All Accounts,” the
corresponding button in the toolbar or the “Disconnect All Accounts” command in the context menu of the
“accounts” window. You can disconnect a separate account from the server using the “Disconnect Account”
command in the context menu in the “accounts” window.
If there are related accounts with different deposit currencies, the background menu contains an additional
order called “summary currency.” It allows the selection of the currency that will be used to explain the overall
result of all accounts, in addition, it affects the estimation of the total volume allocation between orders when
opening positions.
2.3.

Account Details

The account information can be accessed once the account has been linked to the server. After selecting
the “Account Details” in the “Accounts” window context menu, or double-clicking on the account, the window
showing the account information appears.
This window’s “Trade” tab shows the account’s current open positions, account balance line, and the open
positions’ financial performance, as well as the pending placed orders. All trade operations are shown as a
table which contains the following fields:
• Order - the operation ticket number. This is the unique number of the trade operation;
• Time - a time when the position was opened. The record appears as YYYY.MM.DD HH: MM. It is this
time when the position was opened;
• Type - a type of trade operation. There are some types of trade operations available: “Buy” - a long
position, “Sell” - a short position and pending orders Sell Stop, Sell Limit, Buy Stop and Buy Limit;
• Symbol - this field shows the name of security used in a trade operation;
• Lots - the number of lots used in the operation. The minimum amount of lots allowed in operations is
limited by the brokerage company, the maximum - by deposit available;
• Price - the open price of a position (not to be confused with the current price described below). It is this
price at which the position was opened;
• S/L - the level of the stop-loss order placed. If the order is not specified, zero value will be entered in
this field. If an order was closed by stop-loss or the distance between the current price and the stoploss level of an open order is equal to 1 point, this order field will be red-coloured.
One can find more details about order management in the corresponding section;
• T/P - the level of the take-profit order placed. If the order is not specified, zero value will be entered in this
field. If an order was closed by take-profit or the distance between the current price and the take-profit
level of an open order is equal to 1 point, this order field will be green-coloured.
One can find more details about order management in the corresponding section;
• Time - a close time of a position. The record appears as YYYY.MM.DD HH: MM. This field must be
empty for open positions and pending orders placed;
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• Price - the current price of the security (not to be confused with the open price of the position described
above) or the close price of a position;
• Commission - fees charged by the brokerage company for trading operations made are written in this
field;
• Taxes - taxes charged on commission;
• Swap - swaps are fixed in this field;
• Profit - the financial result of the trade considering the current price is given in this field. A positive
value means that the trade was profitable, a negative value means that the trade was losing;
• Expiration - expiration time for a pending order. This field must be empty for market orders and for
those pending orders, for which the expiration time was not specified.
Using the context menu commands, the benefit from the positions can be shown in percentages, in the term
currency or the deposit currency. The account trading history can be requested using the context menu command “History” or a button corresponding to it. The same time the window will appear in which you can assign
one of the request’s predefined intervals or a specific time frame. The context menu command “Save As” and
the corresponding button allow to save a report as an HTML file about account trading.
2.4.

Security Tab

The “Security” tab in the “Account Details” window allows you to change the account password for the master
or the investor. Changing a password involves entering the current account password, the new password,
then checking the new password and pressing “Change.”
2.5.

Open Orders

Currently, open positions and pending orders placed are displayed in the “Orders” tab. All trade operations
are shown as a table with the following fields (from left to right):
• Order - the operation ticket number. This is the unique number of the trade operation;
• Login - trade account number;
• Time - a time when the position was opened. The record appears as YYYY.MM.DD HH:MM (year.month.
day hour:minute). It is this time when the position was opened;
• Type - a type of trade operation. There are some types of trade operations available: “Buy” - a long
position, “Sell” - a short position and pending orders Sell Stop, Sell Limit, Buy Stop and Buy Limit;
• Symbol - this field shows the name of security used in a trade operation;
• Lots - the number of lots used in the operation. The minimum amount of lots allowed in operations is
limited by the brokerage company, the maximum - by deposit available;
• Price - the open price of a position (not to be confused with the current price described below). It is
this price at which the position was opened;
• S/L - the level of the stop-loss order placed. If the order is not specified, zero value will be entered in
this field. If the distance between the current price and the stop-loss level becomes less than or equal
to 10 points, this field of the order is coloured red. If the distance shortens to 1 point, it becomes yellow.
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One can find more details about order management in the corresponding section;
• T/P - the level of the take-profit order placed. If the order is not specified, zero value will be entered
in this field. If the distance between the current price and the take-profit level becomes less than or
equal to 10 points then this field of the order is coloured green. If the distance shortens to 1 point, it
becomes yellow.
One can find more details about order management in the corresponding section;
• Price - the current price of the security
• Commission - fees charged by the brokerage company for trading operations made are written in this
field;
• Taxes - taxes charged on commission;
• Swap - swaps are fixed in this field;
• Profit - the financial result of the trade considering the current price is given in this field. A positive value
means that the trade was profitable, a negative value means that the trade was losing;
• Expiration - expiration time for a pending order. This field must be empty for market orders and for
those pending orders, for which the expiration time was not specified.
• Comment - the order comment specified at its placing.
Using the context menu commands, the benefit of the positions can be seen in percentages, in the term
currency or in the deposit currency. The account trading history can be requested using the context menu
command “History” or a corresponding button. The command “Save” context menu and the corresponding
button allow a report to be saved as an HTML file about the account trading.
If there are linked accounts with different deposit currencies, the context menu will display an additional
command called “Summary currency” It allows the selection of the currency that will be used to represent the
overall outcome of all accounts, and also affects the estimation of the total amount distribution between the
orders when opening positions.
2.6.

Trade History

The “History” tab displays closed positions and cancelled pending orders of the account. All trade operations
are displayed as a table with the following fields (from left to right):
• Order - the operation ticket number. This is the unique number of the trade operation;
• Login - trade account number;
• Open Time - a time when the position was opened. The record appears as YYYY.MM.DD HH: MM.
It is this time when the position was opened
• Type - a type of trade operation. There are some types of trade operations available: “Buy” - a long
position, “Sell” - a short position and pending orders Sell Stop, Sell Limit, Buy Stop and Buy Limit;
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• Lots - the number of lots used in the operation. The minimum amount of lots allowed in operations is
limited by the brokerage company, the maximum - by deposit available;
• Symbol - this field shows the name of security that is used in the trade operation;
• Price - the open price of the position (not to be confused with the current price described below). It
is this price at which the position was opened;
• S/L - the level of the stop-loss order placed. If the order is not placed, zero value will be entered in
this field. If an order was closed by stop-loss, this field has a red background.
One can find more details about order management in the corresponding section;
• T/P — the level of the take-profit order placed. If the order is not placed, zero value will be entered
in this  field. If an order was closed by take-profit, this field has a green background.
One can find more details about order management in the corresponding section;
• Close Time - a time of closing a position or time of pending order deletion. The record appears as
YYYY.MM.DD HH: MM
• Price - the close price of the position;
• Commission - fees charged by the brokerage company for trading operations made are written in this
field;
• Taxes - taxes charged on commission;
• Swap - swaps are fixed in this field;
• Profit - the financial result of the trade considering the current price is given in this field. A positive
value means that the trade was profitable, a negative value means that the trade was losing;
• Expiration - expiration time for a pending order. This field must be empty for market orders and for
those pending orders, for which the expiration time was not specified.
• Comment - the order comment specified at its placing.
The profit of positions can be displayed in points, in the term currency or the deposit currency using the
context menu commands. The account trading history can be requested using the “History” command of the
context menu or a corresponding button. The “Save “ context menu command and the corresponding button
allow saving a report about the account trading as an HTML file. Using the corresponding commands of the
context menu, one can request for the accounts trading histories for various periods. The chosen period also
affects reports that are saved using the corresponding command mentioned above.
If there are connected accounts with different deposit currencies, an additional command “Summary currency” appears in the context menu. It allows choosing the currency that will be used for the representation of
the total result of all accounts, also it affects the calculation of the allocation of the total volume between the
orders when opening positions.
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3. TRADING
The essential rule of profitable trading at financial markets is to buy inexpensive and sell costlier. Accordingly,
the whole trading activities at financial markets come to the successful operations carried out to sell or buy
securities. To accomplish that, one has to open, modify, and near trade positions. trade position is a market
order, the number of bought or sold contracts for which no set-off transactions were made. To open a trade
position, one has to make a transaction and to close a position, one has to make an inverse operation.
3.1.

Order Types

MultiTerminal authorizes requests to be put together and allows the broker to carry out trading operations.
The terminal lets open positions be monitored and handled. Several forms of trading orders are used for
those purposes. Order is the obligation of a patron to perform a trade transaction with a brokerage enterprise.
Inside the terminal, the following instructions are used: market order, pending order, stop-loss and take benefit.
3.1.1. Market Order
A market order is an agreement with the trading firm to buy or sell a security at the present price. Implementation of this order results in the creation of a role in trade. Securities are acquired at Offer price and sold
at Request. You may connect the order stop-loss and take-profit to a market order. The mode of executing
market orders depends on the traded defense.
3.1.2. Pending Order
Pending order is the client’s commitment to the brokerage company to buy or sell a security at a predefined
price in the future. This type of orders is used for opening a trade position provided the future quotes reach
the pre-defined level. There are four types of pending orders available in the terminal:
• Buy limit - buy provided the future “ASK” price is equal to the pre-defined price. The current price level
is higher than the value of the placed order. Orders of this type are generally placed in anticipation of
that the security price, having fallen to a certain stage, will increase;
• Buy stop — buy provided the future “ASK” price is identical to the predefined value. The current price
level is lower than the value of the placed order. Orders of this type are normally placed in anticipation
of that the security price, having reached a sure level, will keep on increasing.
• Sell limit - sell provided the future “BID” price is identical to the pre-described value. The current price
level is lower than the value of the placed order. Orders of this type are usually placed in anticipation
of that the security price, having increased to a certain level, will fall.
• Sell stop - sell provided the future “BID” price is identical to the predefined value. The current price
level is higher than the value of the placed order. Orders of this type are generally positioned in anticipation of that the security price, having reached a certain level, will keep on falling.
3.2.

The setting of Pending Orders

Orders of stop-loss and take-profit can be connected to a pending order. After a pending order has triggered,
its stop-loss and take-profit stages will be attached to the open position automatically.
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3.2.1. Stop-Loss
This order is used for minimizing losses if the security price has started to move in an unprofitable direction.
If the security price reaches this level, the placement will be closed automatically. Such orders are continually
attached to an open position or a pending order. The brokerage enterprise can place them simplest together
with a market or a pending order. Terminal checks long positions with BID price for meeting of this order provisions, and it does with ASK charge for brief positions.
3.2.2.   Take-profit
Take-profit orders are created for gaining the profit when the security price has reached a certain degree.
Execution of this order results in closing a position. it is continually connected to an open position or a pending order. The order can be requested only together with a market or a pending order. Terminal tests long
positions with BID price for meeting of this order provisions, and it does with ASK charge for brief positions.
Attention:
• Execution prices for all trade operations are defined by the broker.
• Stop-loss and Take income orders can best be accomplished for an open position, but now not for
pending orders.
3.3.

Types of Execution

There are three order execution modes in the multiterminal:
3.3.1. Instant Execution
In this mode, the order is executed at the price offered to the broker. At sending the order to be executed, the
terminal sets the current prices in the order. If a broker accepts the prices, the order will be executed. If not,
the so-called “Requote” will occur: broker returns prices at which the order can be executed.
3.3.2. Execution on Request
In this mode, the market order is executed at the price previously received from the broker. Prices for a certain market order are requested from the broker before the order is sent. After the prices are received, order
execution at the given price can be either confirmed or rejected.
3.3.3. Execution by Market
In this order execution mode, a broker decides the order execution price without any additional discussion
with the trader. Sending of the order in such a mode means advance consent to its execution at this price.
Attention:
Execution mode for each security is defined by the brokerage company.
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4. TRADE ORDERS
The basic and clear rule of successful financial-market trading is to buy cheaper and sell dearer. Thus, all
financial-market trading practices come to the successive operations undertaken to sell or purchase securities. To do so, trade positions have to be opened, updated, and closed. Trade position is a market engagement (order), the amount of contracts bought or sold for which no set-off transactions were made. The entire
trade in the terminal is carried out by means of commercial positions. MultiTerminal provides a wide variety
of possibilities for the management and control of trade positions:
4.1.

New Order

Opening of a position or getting into the market is the preliminary buying or selling of a certain volume of the
traded security. A position will be opened both at execution of a market order and automated execution of a
pending order.
4.2.

Market Order

Positions may be opened through the “New Order” tab. Positions for all or some of the managed accounts
may be opened in this tab. Each linked account is represented as a table line. If there is no necessity to open
positions for an account, this accounting line in the table should be unchecked.
When opening positions, it is essential to specify their information:
• Image - the safety, on which positions are being opened.
• Stop-loss - prevent Loss order stage (non-obligatory).
• Take-profit - take-profit order degree (optional).
Attention:
• Zero values of preventing loss and take-profit orders mean that the orders have not been located in
any respect.
• Comment - non-compulsory comment. Its length may not exceed 25 characters. The brokerage company can add to the comment its data up to 6 characters long or replace it. After the position has
been opened, the comment cannot be modified.
• Total volume - total volume (overall amount of masses) of trades in accounts. the total volume is
allocated between accounts in line with the preset volume allocation approach.
Lots Allocation - method of the total volume allocation amongst accounts:
• Predefined volume - the predefined volume will be used at placing orders. It will likely be essential to
specify manually the masses amount for each order by double-clicking in the “volume” area, later this
pre defined volume will follow at placing orders.
• Total volume for every order - the total volume can be used at placing of each order.
• Equal parts - the total volume will be allocated amongst all orders in equal parts.
• On equity ratio - the total volume can be allocated between orders in line with the accounts equity ratio.
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• On free margin ratio - the total volume can be allocated among orders in line with the accounts free
margin ratio.
Attention:
• When the total volume is allocated among orders on accounts with different deposit currencies based
on equity ratio or loose margin ratio, the equity or loose margin are added to the summary currency
that may be selected in the context menus of the accounts panel and the Orders or history tabs.
• Maximum deviation from quoted price - the maximum deviation value given in points. If the broker re
quotes, the new price deviation from the formerly quoted price is calculated. If this deviation is less
or identical to the preset parameter, the order will be accomplished at the new price with no additional
notifications. In any other case, the broker returns new prices, at which the order may be carried out.
Attention:
• The deviation in placing orders is only used in the Instant Execution mode.
• After all the important information was specified, it is essential to press “sell” or “buy”. The order to
open a brief or a long position, respectively, will be sent to the broker. If it is necessary, one can send
the order to open a position for only one account via pressing the corresponding button in the account
line.
Attention:
• If the orders are accomplished by request for the chosen security, it is necessary to press “Request”
before the quotes start incoming. The quotes incoming after request will be active for only some
seconds. If no selection is made in this era of time, “sell” and “buy” will be blocked once more.
• If stop-loss and take-profit levels were too close to the current price throughout opening the position,
the message of “Invalid S/L or T/P” will appear. It is essential to move the levels from the current price
and re-request to place the order. The trade position may be opened after the brokerage company
has made a trade and placed stop-loss and take-profit.
4.3.

Pending Orders

To open a position using a pending order, it is important to place it as defined in the “Pending Order” section.
If the current prices follow the order situation, the pending order will be executed automatically, i.e. a new
trade position can be opened. If stop-loss and take-profit orders had been connected to the pending order,
they may be automatically attached to the newly opened position.
4.4.

Close Order

Buying or selling a security opens a trade position. Then, it is appropriate to close the position
to earn profits on bid-and-ask prices. Trade operation of closing a position is an opposite operation compared
to the opening operation. For instance, if the primary trade operation was buying 1 lot of GOLD, one has to
sell 1 lot of the same security to close the position. Positions can be closed in three ways: close of a single
position, close of a position by an opposite position, and multiple close of all opposite positions.
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4.5.

Closing a Single Position

Positions can be closed manually in the “Close” tab. All or some positions can be closed in this tab for all,
or selected managed accounts. Any linked account that has open positions and all open positions is represented as a table line. If there is no need to close positions for an account, the line of this account must be
unchecked in the table. If not all positions need to be closed, check the required positions in the table.
When a symbol’s positions are closed in Instant Execution mode, the maximum allowable deviation from the
requested price can be preset. If the broker requotes, it calculates the deviation between the requested price
and the initially requested. If the deviation is less than or equal to the preset parameter, the order is executed without further notification at the requested price. Otherwise the broker will return new prices at which to
execute the order.
If necessary, an order may be sent to close positions of only one account or to close only one position by
pressing “Close” in the account line or in the line of position.
Attention:
• In the mode of Request Execution, the proposed quotes will be active for only a few seconds. If no
decision is made within this period of time, “Close” will be blocked again;
• The terminal allows partial close of a position. For this, before pressing “Close”, one has to specify in
the “Volume” field a smaller value than that of the open position;
• Brokers can close positions, too. For example, this can be done if the price reaches the “Stop Out”
level set up by the broker.
A single open position will be closed automatically if prices reach levels of the stop-loss or take-profit orders.
Attention: When a long position is being closed, the Bid price must reach the stop order level (stop-loss or
take-profit), for short positions - the Ask price should reach those levels.
4.6.

Close By Order

An opposite position is known as a counter position to the given one on the same symbol. If there is one or
more counter positions between open positions, the counter one will close the selected position.
You can seal counter positions using the “Close By” tab. In this tab, for all or selected accounts managed, one
can close a position by counter position. Any linked account that has open counter positions for is described
as a table line. If an account has no need to close positions, this account must be unchecked in the table. The
position to be closed must first be selected in the account line (in its list of popup positions), then a counter
position must be verified in.
If counter positions have lots of different numbers, only one remains open. The volume of this position (the
number of lots) would be the difference between the volumes of positions that have just closed. The path
(short or long) and the open price of this new position will be equal to the larger of closed positions (in volume).
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4.7.

Multiple Close By Order

Multiple close of several counter positions allows for the simultaneous closure of more than two counter positions for one symbol.
Using the “Many Close By” tab to close many counter positions. In this tab you can close counter positions for
all or any of the managed accounts. Every account that has open counter positions and each open position is
described as table lines. If an account has no need to close positions, this account line has to be unchecked
in the table. You need to select “Many Close By” to close counter positions for a mark.
If the difference between the volume sums of counter positions is not equal to zero, the operation will result
in an open. The newly opened position will further participate in multiple close but in accordance to its open
time, and so on until either all positions are closed or the last resulting position is opened.
4.8.

Pending Order

Pending orders can be placed using the “Pending” tab. Pending orders for all or some of the managed accounts can be placed using this tab. Every connected account is represented as a table line. If there is no
need to place a pending order for an account, this account must be unchecked in the table.
At placing pending orders, it is necessary to specify their details:
• Symbol - the security, for which pending orders are placed.
• Stop-loss - stop-loss order level (optional).
• Take-profit - take-profit order level (optional).
Attention:
• Zero values of stop-loss and take-profit orders mean that the orders are not placed at all.
• Comment - non-obligatory comment. Its length may not exceed 25 characters. The brokerage company
can add to the comment its own information up to 6 characters long or completely replace it. After the
position is opened, the comment cannot be changed.
• Total Volume - total volume (total amount of lots) of trades in accounts. The total volume is allocated
among accounts according to the preset volume allocation method.
Lots Allocation - method of the total volume allocation among accounts:
• Predefined volume - the predefined volume will be used at placing orders. It will be necessary to
specify manually the amount for each order by double-clicking in the “Volume” field, later this predefined
volume will apply at placing orders.
• Total volume for each order - the total volume will be used at placing of every order.
• Equal parts - the total volume will be allocated among all orders in equal parts.
on equity ratio - the total volume will be allocated among orders according to the accounts equity ratio.
on free margin ratio - the total volume will be allocated among orders according to the accounts free
margin ratio.
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Attention: When the total volume is allocated between orders on accounts with different deposit currencies
based on equity ratio or free margin ratio, the equity or free margin are added to the Summary Currency that
can be chosen in the context menus of the Accounts panel and of the Orders or History tabs.
• Open Price - price level, at which the order must trigger.
• Type - type of the pending order: Buy Limit, Buy Stop, Sell Limit, or Sell Stop.
• Expiry - set the time period, within which the order is valid (optional). If the order does not trigger until
this time, it will be deleted automatically.
Attention: The expiration value may not be less than 10 minutes.
After all necessary data have been entered, it is necessary to press “Place”. A pending order execution is
divided into two stages. After the order has been requested, the broker places it. At the second stage, if prices
comply with the order conditions, the order will be deleted and a trade position will be opened instead. This
open position ticket will coincide with the pending order ticket. If it is necessary, the pending order can be
placed for only one account by pressing the corresponding button in the account line in the table.
Attention:
• Stop-loss and take-profit orders trigger only on open positions and do not work on pending orders.
• If an order is not placed when pressing the “Place” button you should check the correctness of the
stop- loss and take-profit orders. For example, an order will not be placed if you set the value of the
stop-loss larger than take-profit when trying to buy.
4.9.

Modify Order

Modifying the current position is setting new stop order levels (stop-loss or take-profit). For pending orders
open price and expiration time can also be changed. Positions and pending orders are modified in the “Modify” tab. All or some of positions or orders can be modified in this tab for all or some of the managed accounts.
Every connected account that has open positions or pending orders and every open position are represented
as table lines. If there is no need to modify positions and orders for an account, the corresponding line in the
table must be unchecked. If only some of positions or orders should be modified, these positions or orders
should be checked in the table.
When modifying orders, the fields to be changed must be checked and the new data must be entered:
• Stop-loss - the level of a stop-loss order.
• Take-profit - the level of a take-profit order.
Attention: Zero values of stop-loss and take-profit mean that these orders were not placed at all.
• Open Price - price level, at which the pending order must trigger.
• Expiry - set the expiration time for a pending order. If the order does not trigger before this time, it will
be deleted automatically.
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Attention: The expiration time may not be less than 10 minutes.
If it is necessary, positions and orders can be modified for only one account, or one can modify only one position or order by pressing “Modify” in the account line or in the order line.
Attention: The “Modify” buttons will become active after you correctly specify the above mentioned parameters.
If the levels of stop-loss and take-profit are too close to the current price during order modifying, the message
of “Invalid S/L or T/P” will appear. The stop levels must then be moved from the current price and the repeated
request for placing stop orders should be sent. A trade position will be opened after the brokerage company
has executed a trade operation and placed stop-loss and take-profit.
4.10. Delete Order
Should the situation on the market change, a pending order may need to be deleted. You can delete pending
orders via the “Delete” tab. In this tab you can delete some or all pending orders for some or all of the managed accounts. Every connected account that has pending orders and every pending order are represented
as table lines. If there is no need to delete pending orders for an account, the line of this account in the table
must be unchecked. If there is a need to delete only some of pending orders, they must be checked in the
table.
If it is necessary, pending orders can be deleted for only one account or one can delete only one pending
order by pressing “Delete” in the account.

5. ANALYTICS
5.1.

News

The list of incoming news is stored in the “News” tab. The news topics are represented as a table and arranged according to the incoming time. The news incoming time, its topic and category are published in the
table. This list is updated automatically at incoming of the latest news.
The following commands are available in the context menu:
• View - view selected news. One can also read news by double-click with the left mouse button on the topic;
• Category - show/hide the “Category” column;
• Auto Arrange - automatic arrangement of columns when changing a window size;
• Grid - show/hide grid to separate columns.
Attention:
If the “Enable news” option is disabled in terminal settings, news will not appear.
If the given account has no appropriate rights, this can be one of the reasons why news do not income or
cannot be viewed.
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5.2.

Alerts

Alerts tab contains information about created alerts. The alerts are intended for signaling about events in the
market. Having created alerts, one may leave the monitor as the multiterminal will automatically inform about
the server events.
All alerts in this tab are represented as a table with the following fields:
• Symbol - security, the data on which are used to check for the condition specified. If the “Time=”
parameter (alert triggering at the pre-defined time) was selected as a condition, the symbol does not
matter;
• Condition - condition under which the alert will trigger. The following can be used as such a condition:
• Bid> - the Bid price is higher than the specified value. If the current Bid price exceeds the given value,
the alert will trigger;
• Bid< - the Bid price is lower than the specified value. If the current Bid price goes under the given
value, the alert will trigger;
• Ask> - the Ask price is higher than the specified value. If the current Ask price exceeds the given
value, the alert will trigger;
• Ask< - the Ask price is lower than the specified value. If the current Ask price goes under the given value,
the alert will trigger;
• Time= - time is equal to the given value. As soon as this time comes, the alert will trigger.
• Counter - the amount of alert triggerings;
• Limit - maximum permissible amount of the alert triggerings. Having triggered this given amount of
times, the alert will stop triggering;
• Timeout - the period of time between alert triggerings;
• Event - the action to be performed. This can be an audio signal, a file executable in an operational
environment, or a message sent by email.
5.3.

Alerts Management

The following context menu commands are intended for managing alerts:
• Create - create a new alert. The same action can be performed by pressing the Insert key;
• Modify - edit the alert. The same action can be performed by double-clicking on the alert name in the
table or by pressing the Enter key;
• Delete - delete the alert. This action can also be performed by pressing the Delete key;
• Enable / Disable - enable/disable the alert. The alert will not be deleted when disabled, but it stops
to trigger. It can be enabled later. The same action can be performed by pressing the Space key or
enabling in the alert setup window (described below).

PRIMUS MARKETS INTL Limited
Address: Govant Building, BP 1276, Port Vila, Vanuatu
Phone: +27 105004213
E-mail: support@fxprimus.com
Company Number 14595
FXPRIMUS.com/INT

18

Attention:
•   To manage alerts with the keyboard, one should activate this window first. To do so, it is necessary to click
with the left mouse button in the window.
• One can start modifying an alert by double-clicking of the left mouse button in the alert information line.
In this case, as well as at execution of the “Modify” and “Create” context menu commands, the alert editor
window will appear:
• Enable - alert on/off. When the alert is off, it is not deleted, but it will stop functioning. This option is
similar to the “Enable On/Off” context menu command and pressing of the Space key;
• Action - assign an action to be performed when an event happens: play a sound, run a file, or send
an email. When playing a sound or running a file, one should specify the corresponding files. At
sending a message, one should specify the topic and text of the message;
• Symbol - security, the values of which will be used to check the condition;
• Condition - condition (“Time=”, “Bid<”, “Bid>”, “Ask<”, “Ask>”) under which the alert will trigger;
• Value - check the value of the condition. If the symbol price is equal to this value, the alert will trigger;
• Source - the alert. When a sound is played or a file is run, one should specify the path to the corresponding file. When a message is sent by email, one should input the message. It must be noted that one
should set up email parameters for sending message;
• Timeout - the time period between alert triggerings;
• Maximum iterations - maximum amount of times the alert triggering repeats.
The “Test” button allows us to check the usability of the selected alert. For changes to come into effect, one
must press the “OK” button.
Attention:
To send messages about events happening, one has to set up mailbox parameters in the program settings.

6. USER INTERFACE
6.1.

Main Menu

The main menu consists of the following sub-menus:
•
•
•
•
•
•

File
Edit
View
Tools
Window
Help
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6.1.1. File Menu
The File menu contains commands for managing accounts, and for printing and saving reports. The following
commands are available in the menu:
•

Connect All - connect all account to the server;

•

Disconnect All - disconnect all accounts from the server;

•

New Account - add new account to the list of managed accounts;

•

Save - save the list of orders or accounts history;

•

Print - print the list of orders or accounts history;

•

Print Preview - preview before printing;

•

Print Setup - common print setup;

•

Exit - close the program.

6.1.2. Edit Menu
The Edit menu contains find and copy commands. The following commands are available in the menu:
• Copy - copy selected data into clipboard;
• Find - finding a list element according to the given criterion;
• Find Next - continue the search and find the next list element.
6.1.3. View Menu
The View menu includes commands for handling signal frames, the toolbar and the language of the user interface. The toolbar duplicates some of those commands. The following commands can be found under the
menu:
• Languages - call the sub-menu managing languages of the terminal. Having selected a desired
language, one can switch the terminal interface to this language. For the changes to take effect, the
program must be restarted.
• Toolbar - show or hide the toolbar of the terminal.
• Status Bar - show or hide a status bar located in the lower part of the terminal window.
• Market Watch - open/close the “Market Watch” signal window where the current quotes are published.
The same action can be performed by accelerating buttons of Ctrl+M or by pressing the corresponding
button of the toolbar.
• Accounts - open/close the “Accounts” window where the list of managed accounts is located. The
same action can be performed by accelerating buttons of Ctrl+A or by pressing the corresponding
button of the toolbar.
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• Toolbox - open/close the “Toolbox” window. One can manage signals in this window, look through the
news, emails, and journals. The same action can be performed by accelerating buttons of Ctrl+T or
by the corresponding button of the toolbar.
• Full Screen - enable/disable the full screen mode. As soon as this option is enabled, the toolbar and
status bar will be disabled and all signal windows will be closed. The terminal heading, main menu,
workspace remain on the screen. The repeated execution of the command returns the terminal to the
initial appearance.The same action can be performed by F11 button or by the corresponding button
of the toolbar.
6.1.4. Tools Menu
The Tools menu contains the only command to open the terminal settings window.
Options - open the terminal setting window. One can set up parameters for connection, trades, emails, and
events in this window. More details can be found in the “Terminal Settings” section. The Options window can
also be called by accelerating keys of Ctrl+O or by a corresponding button of the toolbar.
6.1.5. Window Menu
The Window menu contains commands for switching between order and trade windows.
• Orders - switch to open orders window;
• History - switch to trade history window;
• New Order - switch to new orders window;
• Close Order - switch to close orders window;
• Close By - switch to close by orders window;
• Multiple Close By - switch to multiple close by orders window;
• Pending Order - switch to placing pending orders window;
• Modify Order - switch to modifying orders window;
• Delete Order - switch to deleting pending orders window;
6.1.6. Help Menu
The Help menu is auxiliary. Execution of the menu commands does not influence the terminal operation in
any way. One can do the following from this menu:
•   Help Topics - open the built-in help files containing this present User Guide. All settings and functions of
the MultiTerminal are described in it. The F1 button performs the same action.
•   About... - open the “About...” window where one can find information about the company, its contact details,
and the terminal version, as well.
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6.2.

Toolbar

The key commands used in the terminal are duplicated in buttons type in the toolbar. The toolbar is usually
located under the main menu but it can be conveniently transferred to any window section of the application.
The toolbar can be displayed or hidden by the menu command “Open-Toolbar.” Toolbar is adjustable, allowing only required, frequently used commands to be put within it. To set up a toolbar, open its context menu
(right mouse-click) and execute the command “Customize ....”
The following commands are available in the toolbar:
• Connect All - connect all accounts to the server;

• Disconnect All - disconnect all accounts from the server;

• New Account - add a new account to the list of managed accounts;
• Save - save the list of orders or accounts history;
• Print - print the list of orders or accounts history;
• Print Preview - preview before printing;

• Find - finding a list element according to the given criterion;

• Find Next - continue the search and find the next list element.

• Market Watch - open/close the “Market Watch” signal window.
• Accounts - open/close the “Accounts” window.
• Toolbox - open/close the “Toolbox” window.

• Full Screen - enable/disable the full screen mode.
• Options - open the terminal setting window.

• Help Topics - open the built-in help files containing this present “Userguide”.
6.3.

Market Watch

The securities (symbols), for which the terminal gets quotes from the server, are listed in the “Market Watch”
window. The data are represented in this window as a table having several fields. The “Symbol” field contains the security name, the fields of “Bid”, “Ask”, and “Time” show the corresponding prices and time of their
income from the server. Values of the “Maximum” and “Minimum” fields are calculated on the basis of price
changes within a day. The “Market Watch” window can be opened/closed by pressing accelerating keys of
Ctrl+M, by the “View — Market Watch” menu command, or by pressing the corresponding button of the toolbar.
At the right mouse button click in the “Market Watch” window, the context menu will appear where the following commands are available:
• Tick Chart - open the tick chart of the symbol selected. The tick chart is located directly in the “Market
Watch” window. The tick chart of the selected symbol can also be viewed by switching to the tab of
the same name in the same window.
• Hide - delete (hide) the symbol from the list. To minimize the traffic, it is recommended to hide unused
securities from the quotes window by this command or by pressing the Delete button.
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Attention:
If there are open positions or pending orders for the symbol, the symbol cannot be deleted.
• Hide All - delete all symbols from the list. This command does not apply to securities for which there
are open positions.
• Show All - show the list of all available securities. After this command has been executed, quotes will
be income for all these symbols.
• Symbols - open the window of the same name with a list of all available symbols. Symbols are grouped
in the window according to their types. The “Show Symbol” command allows you to add necessary
symbols to the quotes window, and that of “Hide Symbol” - to delete a symbol from it. The “Properties”
window command allows to view the symbol parameters (spread, digits, stops level, etc.).
• High/Low - add the highest and the lowest values of the daily price to the quotes displayed.
• Time - show time of incoming quotes.
• Auto Arrange - automatic arranging of columns when changing the window size. Auto Arrange can
also be enabled by pressing A button;
• Grid - show/hide the grid separating columns. The grid can also be shown by pressing G button;
• Popup Prices - open an additional quotes window. The list of symbols in this window is the same as
that in the “Market Watch” window at the moment of the command execution. This means that changes
in the symbol list in the “Market Watch” window do not influence that in the “Popup Prices”. In the
context menu of this window, there are commands allowing to set up data displaying parameters,
enable the full screen mode, or locate the window over all others.
6.4.

Contract Specification

The symbol contract specification window contains the terms of a symbol trading. To view the symbol properties, select “Specification” in its context menu in the “Market Watch” window.
The window displays the following parameters set by a broker:
• Spread - spread in points. If the spread is floating, the parameter is equal to 0.
• Digits - number of decimal places in the price of the symbol;
• Stop level - channel of prices (in points) from the current price, inside which one cannot place stoploss, take-profit and pending orders. When placing an order inside the channel, the server will return
the “Invalid Stops” message and will not accept the order;
• Freeze Level - level for freezing orders that are close to the current price. When an order price is as
close to the market price as the value specified here or less than that, modification, deletion or closing
of the corresponding position or order is prohibited;
• Contract size - number of units of the commodity, currency or financial asset in one lot;
• Margin currency - currency in which the margin requirements are calculated;
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• Profit calculation mode - Forex, CFD or Futures;
• Margin calculation mode - Forex, CFD, Futures; CFD-Index, CFD-Leverage;
• Margin hedge - margin charged from hedged orders for 1 lot;
• Margin percentage - determines what part of the base margin size value calculated according to the
symbol type is charged;
• Trade - permission to trade with this instrument: “Full access” allows to close and open positions;
“Close only” allows only closing; “Disabled” - full prohibit to trade;
• Execution - execution type of the symbol: Instant, Request or Market;
GTC mode - expiration mode of orders:
• Pendings are good till cancel - pending orders are preserved as a trade day changes;
• Good till today including SL/TP - orders that are valid only during one trading day. With the end of the
day, all levels of stop-loss and take-profit, as well as pending orders are deleted.
• Good till today excluding SL/TP - when a trade day changes, only pending orders are deleted, stoploss and take-profit levels are preserved.
• Minimal volume - minimal volume of a deal for the symbol;
• Maximal volume - maximal volume of a deal for the symbol;
• Volume step - step of volume changes.
Swap type - type of swap calculation:
• In points - the specified number of points of the security price.
• In the base currency - the specified amount in the base currency of the symbol.
• In percentage terms - as a percentage per annum. The percentage is taken from the position price
(per 1 lot) and divided by 360, since the swap is calculated daily;
• In the margin currency - the specified amount in the symbol margin currency.
• Swap long - swap for Buy positions.
• Swap short - swap for Sell positions;
• 3-days swaps - the day of triple swap charge;
• First trade - a day of beginning of symbol trading;
• Last trade - a day of end of symbol trading.
The lower part shows information about quoting and trading sessions of the symbol. Sessions are specified
for every day of week.
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6.5.

Mailbox

The “Mailbox” is designed to operate with an internal mailing system. It is in this “Toolbox” window where all
messages where entry to the terminal are stored. They are represented with the following fields as table:
• Time - the time of incoming news;
• To - the recipient log-in;
• From-the name of the sender;
• Subject -Message topic.
You can access the content of the selected message by double-clicking the left mouse button on the appropriate message or the “Open” context menu command and you can delete a message using the “Delete”
command. Furthermore, if the brokerage firm allows, messages may be sent to the system administrator.
6.6.

Journal

All activities and events conducted are written to specific journals of statistics which are described as text
files. The “Article” portion of the “Toolbox” window allows certain entries to be accessed. The information is
expressed in a table form which contains the following fields:
•

Time - the time and date of an event;

•

Message - a summary of an incident that happened.

In the journal only the latest entries of the day are mentioned. To view previous entries you can execute the
context menu command “Open.” The folder which contains the journal’s text files will be opened at the same
time.

7.

COMPANY’S CONTACT DETAILS

7.1.
Clients shall communicate with the Company with the communication methods described within this
document and/or at the following address:
Correspondence Address:
Primus Markets INTL Limited
Govant Building, BP 1276, Port Vila, Vanuatu
Telephone: +27 105004213
Email: support@fxprimus.com
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Primus Markets INTL Limited
Customer Service
Phone: +27 105004213
E-mail: support@fxprimus.com
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